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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the CS+ IDE to develop and
debug software for the RSK platform. It is intended for users designing sample code on the RSK platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in CS+, but does not intend to
be a complete guide to software development on the RSK platform. Further details regarding operating the
RX23T microcontroller may be found in the Hardware Manual and within the provided sample code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX23T Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK hardware. RSKRX23T R20UT3318EG
User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, RSKRX23T R20UT3319EG
running sample code and debugging programs. Tutorial Manual
Code Generator Provides a guide to code generation and importing into RSKRX23T Code R20UT3321EG
the CS+ IDE. Generator

Tutorial Manual ’
Tutorial Manual

Quick Start Guide Provides simple instructions to setup the RSK and run RSKRX23T R20UT3320EG
the first sample, on a single A4 sheet. Quick Start Guide
Schematics Full detail circuit schematics of the RSK. RSKRX23T R20UT3317EG
Schematics
Hardware Manual Provides technical details of the RX23T microcontroller. RX23T Group RO1UHO0520EJ

Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVvD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.



http://www.digilentinc.com/index.cfm
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LENESANS

RSKRX23T

RENESAS STARTER KIT

R20UT3319EG0100
Rev. 1.00
Aug 24, 2015

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK
tutorial started, and basic debugging operations.

1.2 Features

This RSK provides an evaluation of the following features:

The RSK board contains all the circuitry required for microcontroller operation.

Renesas microcontroller programming

User code debugging

User circuitry such as switches, LEDs and a potentiometer
Sample application

Sample peripheral device initialization code

R20UT3319EG0100 Rev. 1.00
Aug 24, 2015 RENESAS
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RSKRX23T 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSK?
e How do | build an embedded application?
e How do | use Renesas’ tools?

The project generator will create a tutorial project with three selectable build configurations:
e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
e ‘Debug’is a project built with the debugger support included. Optimisation level is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no outputs debugging information
options selected, producing code suitable for release in a product.

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

2.1 Code Generator Plug in

The Code Generator plug in for the RX23T has been used to generate the sample code discussed in this
document. Code Generator for CS+ is a plug in tool for generating template ‘C’ source code and project
settings for the RX23T. When using Code Generator, the engineer is able to configure various MCU features
and operating parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to
sections of the Hardware Manual.

Code Generator is not enabled by default during CS+ installation and is not required for this tutorial manual.
For more information please refer to the ‘Enabling Code Generator’ section of the Code Generator Tutorial
manual.

Once the engineer has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the engineer is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the engineer needs to re-
visit Code Generator to change any MCU operating parameters.

R20UT3319EG0100 Rev. 1.00 ———
Aug 24, 2015 RENESAS




RSKRX23T 3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction
CS+ is an integrated development tool that allows the user to write, compile, program and debug a software
project on the RX, 78K, RL and V850 family of Renesas microcontrollers. CS+ will have been installed during

the installation of the software support for the Renesas Starter Kit product. This manual will describe the
stages required to create and debug the supplied tutorial code.

3.2 Starting CS+
To use the program, start CS+:

Windows™ 7 & Vista: Start Menu
(Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX, RH850)’ icon

The first time CS+ is started, the One Point Advice dialog box will be shown:

One Point Advice @

Do you know?

Can e2 studio project be opened?
e? studio project can be loaded in this product.

Select [Project] -» [Open Project.. ], and select a project file {rcpc) of
the &2 studio.

* Displayed contents, random.

027/050 | <Back |[ New> |

7] Do not show this dialog box at startup [ QK ] ’ Help ]

The One Point Advice dialog box provides some useful tips when using CS+. Press ‘OK’ to skip the advice
and close the One Point Advice dialog. The user will then be presented with the Start panel.

Under the ‘Open Sample RSK Project’, open a new Tutorial project by selecting the RSKRX23T_Tutorial
project template and click on ‘Go’ as shown below. This will save a copy of the RSKRX23T_Tutorial project.

Open Sample RSK Project
Select an RSK project template from those installed:
R T Tutorial

Tutoral Project
Tutorial code demonstrating the operation of the debugger.

R20UT3319EG0100 Rev. 1.00 RENESAS Page 9 of 25
Aug 24, 2015
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RSKRX23T 3. Tutorial Project Workspace
CS+ will present a ‘Create Project’ dialog Create Project =]
box. Subprojects to Add : Subproject information :

Select all sub-projects by clicking on e et e cthe MUy
each checkbox and observe the %;ﬁ;;?ﬁrfé:;w e ek Mockiston) otput signl
information displayed under the | Tmer_FWiA
‘Subproject information’ heading as you
select each project.
Specify a name and location for the new
project and click on ‘Create’ Name : RSKRX23T Tutorial
A dialog box will appear if the location DL —
specified does not exist; asking to create —
the folder specified. Click ‘OK’.
= ] [ — ” Help ]
CS+ will create and open the project Froject Tree
showing the Project Tree as seen in the : @ 2 @
screenshot opposite. =-| L RSKRXI3T Tutorial (Project]’ -
RSKRX23T_Tutorial (Project) is the i R5F523T5A%FM (Microcontroller)
master project and includes the tools to Code Generator (Design Teol)
modify, build and debug the code. £ Peripheral Functions
i ; o Code Preview
The File folder seen in thg screenshot | | A, CC-RX (Build Tool)
belongs to the master project, | || i 55! RX E1(Serial) (Debug Tool)
RSKRX23T_Tutorial. w-[ File
This folder contains and lists all project =L fi Application (Subproject)
source and header files including text 48 RSFSZ3T3AKFM (Micracontrolle
files arranged in separate folder -2 Code Generator (Design Tool)
structures. | A CC-RX (Build Tool) L
g, R EL(Serial) (Debug Teol) 1
Folders containing the subprojects, L7 File
indicated by “(Subproject)”, are listed 2| & Async_Serial (Subproject)
below the File folder. £ RSFS23TSAdM (Micracontrallel
Each subproject folder, when expanded, -2 Code Generator (Design Tool)
reveals an identical tools and folder | | " f‘ ;;;‘TS&B;::?(;ZEE Tool
structure to that of.the master project, D‘j]' il J
RSKRXZBT—TUtOHal' = f; Low_Power_Mode (Subproject)
By default the RSKRX23T_Tutorial . RSF523T5AxFM (Microcontrelle
project is set as the active project, 1% Code Generator (Design Tool)
indicated by the line under the project | || i = 4, CC-RX (Build Toel)
name. e =i, RX El(Serial) (Debug Teol)
-9 File
=B ]’; Systern_Input_Capture (Subproject)

Note: ‘Code Generator (Design Tool)' node is 8 RSF523T540FM (Microcontrolle

shown in the ‘Project Tree’ and indicates an -%#| Code Generator (Design Tool)

optional plug-in has been enabled | || i i~ 4, CC-RX (Build Tool)

previous|y. g, R EL(Serial) (Debug Teol)

w-[3P File
= ]’; Timer_PWM (Subproject)
IE RSF523T5AxFM (Microcontrolle
- J Code Generater (Design Tool)
..... A, CC-RX (Build Tool) i
- hos nvrlr'l:l [ ey L o WY NP P} -
R20UT3319EG0100 Rev. 1.00 RENESAS Page 10 of 25



RSKRX23T

3. Tutorial Project Workspace

e To change the active project, right-
click on the project/subproject name
and select “Set x as Active Project”
(x represents the project name).

Project Tree o x

; @ 2 [
=15 RSKRX23T Tutorial (Project)
----- 5‘,% RSF523T54xFM (Microcontroller)
|:-:|F;~I Code Generator (Design Tool)
- A Pin View
. ‘p_;é Peripheral Functions
@48 Code Preview
----- A, CC-R¥ (Build Tool)
----- 2, RX Simulator (Debug Tool)

-3 File
i,

- 12 Build RSKRX23T Tutorial
e
;\ ’q'_] Rebuild RSERX23T Tutorial
5| [ Clean RSKRX23T Tutoria
}l u_:k Open Folder with Explorer
- ﬁ Asy Bl Windows Explorer Menu
[]---| ﬁ Lov
-] ﬁ Sys Add
- ﬁ T|rr| fﬁ Set Application as Active Project
fd Remove from Project Shift+Del
5 Paste Cirl+V
Rename F2
Property
e The File folder contains four Proiect T X,
subfolders. This structure is common roject free
to all projects. 2 @ 8 | [E
e Some of the source files were 5L 1) Code Generator i
generated by Code Generator, which ' ‘fJ led ]
are grouped under the ‘Code | || ¢ i 7 = e pane £
Generator’ folder which itself is listed : —
under the File folder in the Project | [| = | ‘_:J r_ca_ adt @ Compile
Tree. These files are prefixed with | || . e rcgegem 0
‘r_cg’ to indicate that they were | || i i i €| rcg_cge J pEn
generated by a code generator. Al | | & i & r_cqintp. 2 Openwith Internal Editor...
other user-generated source files are & - ; . .
contained in the ‘C Source Files’ e = regintpl [ Open with Selected Applicat
folder. g}: Dpen Folder with Explorer
e To open a file for viewing, right-click
on the file and select ‘Open’.
Alternatively, double-click on the file.
R20UT3319EG0100 Rev. 1.00 RENESAS Page 11 of 25
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RSKRX23T 3. Tutorial Project Workspace

3.3 Configuring the Debug Tool (E1)

Note: The Tutorial sample project’s settings are pre-configured. This section is intended to familiarise the user
with the debug tool settings for when they create their own project.

e The Project Tree will be displayed on the RSKRX23T_Tutorial - C5+ for CC - [Project Tree]
- +,
left-hand pane of CS File Edit | View | Project Build Debug Tool Window

e This can also be invoked from the menu
bar [View > Project Tree)]. &, stan

i Project Tree "

e The opposite screen-shot indicates that
the selected Debug Tool is E1. Project Tree o

: @8 @&

= f5 RSKRX23T Tutorial (Project)”

Code Generator (Design Tool)

A Pin View

i Peripheral Functions
- Code Preview

----- 4, CC-RX (Build Tool)

----- 5 T
E:I""__j!' File ’—Usmg Debug Tool  » | R¥ E1(Serial)
&[5 Application (Subproji 7 property RX E20(Serial)
[]—--|_ﬁ Async_Serial (Subpropecy RY¥ Simulstor
i Gl T Low Power Mode (Subproiect] |I
e Right click on RX E1(Serial) (DebugTool). | E=f Property
e Click on Property. &5l RX E1(Serial) Property
e View the Connect Settings. 4 Internal ROMRAM i
. . Size of internal ROM[KBytes] 128
e Verify that the settings match the Size of internal RAM[KBytes] 12
Opposite screen-shot. Size of DataFlash memory[KBytes] D
4 Clock
Main clock source EXTAL
Main clock frequency[MHz] 20.0000
Operating frequency[MHz] 40.0000

Allow changing of the clock source on writing internal flash memory  No
4 Connection with Emulator

Emulator serial Mo.
4 Connection with Target Board

Power target from the emulator.(MAX 200ma) Yes
Supply voltage 33V
Communications method FINE
FINE baud rate[bps] 2000000

The project is configured to halt code Property

execution on the first instruction of the main

function after programming the micro- @ RXE1(Serial) Property

controller. To specify another function as an 4 Download

entry point: [
CPU Reset after download Yes
Erase flash ROM before download Yes

e View the ‘Download files’ Settings of the

) Erase data flash ROM before download MNo
RX E1’s property. Automatic change method of event setting position Suspend event
¢ Change the ‘specified symbol’ to another 4 Debug Information
available function. Execute to the specified symbol after CPU Reset Yes
e Ensure to prefix the function name with EMT‘%;S"'"‘:“" : ; ﬂma'“
w » Specify the debugged overlay section No
an underscore ( - ) The upper limit size of the memory usage [MBytes] 500
Note: Do not specify an interrupt handler as
the entry point.
R20UT3319EG0100 Rev. 1.00 .zENESAS Page 12 of 25
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RSKRX23T

3. Tutorial Project Workspace

3.4 Build Configuration

The build configurations are selected from the build tool's Property panel. The options available are
‘DefaultBuild’, ‘Debug’ and ‘Release’. ‘DefaultBuild’ and ‘Debug’ are configured for use with the debugger.
‘Release’ is configured for the final ROM programmable code.

A common difference between the two builds is the optimisation setting and the addition of debug information.
With optimisation turned on, the debugger may seem to execute code in an unexpected order. To assist in
debugging it is often helpful to turn optimisation off on the code being debugged.

¢ Right-click on CC-RX (Build Tool) from
the Project Tree.

e Select ‘Property’.

Project Tree 1 x
: @ 8| [
B_ﬁ RSKRX23T Tutorial (Project]
{E R5F523T54xFM (Microcontroller)
: ;‘I Code Generator (Design Tool)
- Pin View
E;J Peripheral Functions
,;D{ Code Preview

BN CC R (Build Zact]

gl R El(Serial) @ Build Project F7
= File =
]l ﬁ Application ( @
"4
=

[ Rebuild Project Shift+F7
[ .

Clean Project

EEl---l ﬁ Async_Serial !

EEI---l ﬁ Low_Power_N Set to Default Build Opticn for Project
E;|---| E System_Input

[

Import Build Cptions...
o[ 5% Timer_PWM

Set Link Crder...

| Property ‘

e The Common Options sheet will open by
default.

e Verify that the Build Mode is set to
‘Debug’.

Property

4\ CC-RX Property
4 BuildMode

Build mode Debug
a CPU
Instruction set architecture REv2 architecture(-isa=raw2)

Click on the ‘Compile Options’ sheet to view
compiler options.

)
\Common Options ), Compile Opti... l,iAssembIeOpﬁo..._,{ Link Options ,{

e Ensure the ‘Outputs debug information’
entry is set to ‘Yes(-debug)’.

e Ensure the ‘Optimization’ entry is set to
‘0O(-optimize=0)’.

’\_ CC-R¥ Property
| v Source
4 Dbject

Dutput file type Object madule file[-output=obj]
Yes|-debug)
Section name of program anea P
Section name of constant area E
Section name of initialized data area D
Section name of uninitislized data area B
Section name of literal area L
Section name of switch statement branch table area W
Allocates uninitialized variables to 4-byte boundary align Mo
Allocates initialized vanables to 4-byte boundary alignme Mo
Allocates const qualified variables to 4-byte boundary ali No
Allocates switch statement branch tables to 4-byte boun Mo

Adjustment for instruction in branch Mone[-noinstalign)
Generates divisions and residues with DIV, DIVU, and t Yes
Character code of an output assembly-language file SJIS code[-outcode=sijis)
> List
4 Dptimization
Optimization level D[-optimize=0)

Outputs additional information for inter-module optimizati Mo

R20UT3319EG0100 Rev. 1.00
Aug 24, 2015

RENESAS Page 13 of 25




RSKRX23T 4. Building the Tutorial Program

4. Building the Tutorial Program

The tutorial project build settings have been pre-configured in the toolchain options. To view the toolchain
options double-click on CC-RX(Build Tool) from the Project Tree and select the available tabs. It is important
when changing settings to be aware of the current configuration before modifying the settings.

¢ Review the options on each of the tabs to
be aware of the options available. For the
purposes of the tutorial, leave all options
at default. - ||

e When complete, the Property panel can
be closed by clicking [x] on the right-hand
corner of the Property window.

4.1 Building the Code

There is a choice of three shortcuts available for building the project:

e Selecting the ‘Build Project’ toolbar button will build all projects listed in the project tree.

e Pressing [F7]. This is equivalent to pressing the ‘Build Project’ toolbar button.

2]

e Selecting the ‘Rebuild Project’ toolbar button will rebuild all project files.

e Selecting the ‘Build & Download’ toolbar button will only build the active project and
download the code to the target device after a successful build.

e Pressing [F6]. This is equivalent to pressing the ‘Build & Download’ toolbar button.

E <@

Build the project now by pressing [F7] or pressing one of the build icons as shown above. During the build
each stage will be reported in the Output Window. The build will complete with an indication of any errors and
warnings encountered during the build.
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4. Building the Tutorial Program

4.2 Connecting the Debugger

For this tutorial the E1 debugger will provide power to the RSK, no external power supply is required.

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to
connect the E1 to the host computer. The following assumes that the steps in the Quick Start Guide have

been followed and the E1 drivers have been installed.

e Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the

socket.

e Connect the E1 Debugger to a free USB port on your computer.
e Connect the E1 Debugger to the target hardware ensuring that it is plugged into the connector marked

‘E1’.

4.3 Saving Project Settings

If you have changed any project settings this is a good time to
save the project.

e Select ‘File’ | ‘Save Project'.

File | Edit “iew Project Build Debug

M ey L
;:L Open.. Ctrl+0

Openwith Encoding... 1

Ldd F

.:E Close Project
Close File

fy SaveProject  Cirl+Shift+S

If you make any changes to files in CS+ and want to preserve
these change, you can save them by:

e Select ‘File’ | ‘Save All".

File | Edit “ieww Project Build Debux
M 3

|k Open.. Ctrl+0

Openwith Encoding...
Add 3

5 Close Project

| Close File
@3 Save Project Ctrl +3hift+3
fﬁ-:; Sawve Project As..,
i Sawe Object Ctrl+5
b Save Object s,

&y Object Save Settings..,

(s al Chrl+Shift+2

You can also save files by clicking the ‘Save’ or ‘Save All
buttons from the CS+ toolbar.

In addition files can be saved using the keyboard shortcut
[Ctrl + S]:

= =
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5. Downloading and Running the Tutorial

5.1 Downloading the Program Code

Now that the code has been built in CS+ it needs to be downloaded to the RSK.

e Click on the program download button.
Alternatively, select Debug from the
Menu bar and click on Download.

« On completion of program download 7 RE R R R R R A R R R R R R SR A R R R R R R R R R KRR R S R
he deb d cod d ’b * Funct ion Name: main
the debugger and code are ready to be # Description @ This function implements main function.
executed. The program counter £ hreuments : None
indicator will point to first line of code * Return Value @ None

AR R O R O R R R R R R R R R R R

inside the ‘main’ function; this is the }?jid e ——

program’s entry point. -

R_MAIN UserInit ();
S Start user code. Do not edit comment zenerated here =/

J% Initialize the switch module %/

R_EWITCH Init ()3

/% Bet the call back function when 881 or SW2 is pressed =/
R_SWITCH_SetPressCal lback (ch_switch_press);

A% Initialize the debug LCD %/
RLCD Init();

/% Displays the application name on the debug LCD #/
RLED Display (D, (uintB_t )7 REVENIZT 7);

R_LCD Display (1, (uintB_t #)7 Tutorial 7); ,
R_LCD Display(2, (uint8_t #)7 Press Anw Switch 75

Before proceeding, it is necessary to connect to the RSK G1CUSBO port to a PC using a USB Type A to mini
B cable. The first time this port is connected to the PC an 'Installing Device Driver Software' pop-up will
appear and the device driver will be automatically installed. Open Device Manager, the virtual COM port will
appear under 'Port (COM & LPT)' as 'RSK USB Serial Port (COMX)', where x is a number. Open a terminal,
emulation program, such as HyperTerminal, with the settings 19200, 8, N, 1 on the virtual COM port.

5.2 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.

Click the ‘Go’ button or press F5 to begin the program from the current program counter @
position. It is recommended that you run through the program once first, and then continue to
the review section. Operating instructions for the program can be found in the file
‘Description.txt’, under the ‘Text Files’ folder in the CS+ Project Tree.
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6. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in CS+.

6.1 Program Initialization

Before the main program can run, the microcontroller must be configured. Due to the debugger configuration
used for the Tutorial project and the rest of the sample projects, the user will not be able to step through the
hardware initialization code. Please refer to Section 3.3 to change the entry point after programming the
microcontroller. Specify ‘_R_Systeminit’ as the function name if viewing of hardware initialization is desired.
The initialization code is executed every time the device is reset via the reset switch or from a power reboot.
The user is advised not to use the ‘step’ feature of the debugger to exit the ‘R_Systeminit’ function.

Ensuring the Tutorial program has been downloaded onto the RX23T; press the ‘CPU Reset’ button
on the Debug Toolbar. s

e From the Menu bar select View >
Disassemble > Disassemblel.
Alternatively, use the Display
Disassemble button to open and

void main(void)
main:

6040

SUB

#4H, RO

R_MAIN UserInit();

ESR.W

R_MAIN UserInit

R_SWITCE Init();
0 BSR.2 R
callback (cb_switch_press)
£ MOV.TL #-
BSR.A R

view the ‘source and disassembly’.

e To make the Display Disassemble
button available on the toolbar,
right-click on the toolbar and select

essCallback

BSR.A
, (uintB_t *)" RSERXZ3T ");
f£ MOV.L

‘View Panels’. uov. L
R_LCD_D. , (uintB_t *)" Tutorial "

<« Disassemble = ot

- button BSR.A

, (uint8 t *)" Press Zny
eff MOV.TL
MOV.TL

BSR.A R _LCD Display
Revert back to the source by clicking on the -
file containing the function pointed to by the
program counter indicator. Alternatively,
right click in the Disassemblel window and
click "Jump to Source”

R20UT3319EG0100 Rev. 1.00
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6.2 Main Functions

This section will look at the program code called from with the ‘main()’ function, and how it works.

e Right click the ‘R_SCI1_Serial_Receive() | 7 ===k & Fi- et
. — - - , t N 5 GoTo.. Cirl+G
function call and select ‘Go to Here’ to B WeeTuivt); e ey P
execute the program up to this line. The T A Backeto Last Cursor ositon
. . y . f* Initialize the switch module */
R_LCD_Init()’ function call enables and 2_SWITCH Init()s 2 GotoHere
Conflgures the LCD panel' and /* Set the call back functi nn SW1 or SW2 is Q =Bl
‘R_LCD_DlspIay()' Wl” erte "RSKRX23T" R_SWITCH_SetPressCallback(c tch_press); 7% Jump to Function F12
onto the top line, “Tutorial” on the second /* Initialize the debug LCD */ o Teglume S
R_ILCD_Init () #%, Jump to Disassemble

line and “Press Any Switch” on the third.

Bookmarks 4
Advanced 3
Break Settings 3
Trace Settings 3
Timer Settings 3
Save Source Mixed Data As...

e Set a breakpoint on the ‘R_SCI1_Start()’ /% Set up BCIN receive buffer and cal Iback function %/
function call by clicking on the On-Chip i R_SCI1_Serial Receive({uint8_t #)&z rx_char, 1);
Breakpoint column to the left of the I Eraliln BB meurdtions
number column. |5 R_SCI1_Starti);

e Click the ‘Step In’ button to step into the —

‘R_SCI1_Serial_Receive()’ function. r—

Alternatively, press [F11].

e The program counter should now move
into the ‘R_SCI1_Serial_Receive()’

| th_STl!TUS R_ECI1_Serial Receive{uint8_t * const rx_buf, uint16_t rx_num)
. . -y . . . [
function definition. This function is an API [
[

MD_STATUS status = MD_OK;
if (10> r_pum)

function provided by the Code Generator.
status = WD_ARGERROR;

It sets up the SCI1 interrupt handler code

to receive a specified number of bytes e{'lae
into a receive buffer. Once the specified 2 scil_mocount = OU;
number of bytes has been received, the gscil_r_length = rxnuns
. gp_scil_rx_address = rx_buf;
interrupt handler code calls a callback SCT1.50R.BIT.RIE = 1U;

B . . . o — -
function as shown later on in this section. , ANl = E

e For full details on how to configure a [
project using Code Generator refer to the
Code Generator Tutorial Manual.

return (status);

e Pressthe ®button to resume program
execution.
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6. Reviewing the Tutorial Program

e The program counter should come to a
halt at the ‘R_SCI1_Start’ function.

e Step over the function by clicking the
‘Step Over’ button. Alternatively, press
F10.

E_

The ‘R_SCI1_Start()’ function enables the
SCl interrupts. The program then proceeds to
the main while() loop. The code inside the
loop waits for user input from either SCI
reception or RSK switches, and then performs
an A/D conversion.

o
=)

J% Bet up SCI1 receive huffer and cal lback function %/
R_SCI1_Serial Receivef{uint8_t #)&z_rx_char, 1);

/% Enable 8CI1 operations */
R_SCI1_Btart();

while (11

e Locate the function call to
‘lcd_display_adc()’ inside the while loop.

e Set a breakpoint on the
‘lcd_display_adc()’ function call by on the
On-Chip Breakpoint column to the left of
the number column.

whiTe (10]
uint16_t ade_result;

/% Wait for user requested &/D conversion flag to he set (8W or SW2) %/
i{f (TRUE == g_adc_trigeer)

/% Call the function to perform an A/D conversion %/
adec_result = zet_adcl);

/% Display the result on the LCD =/

) . % led_display_ade(adc_result);
¢ Inthe Project Tree pane, locate the file
‘r_cg_sci_user.c’ and double-click to open
the source file. Scroll down to the
function ‘r_scil_callback_receiveend()'.
e Set a breakpoint on the line of code inside | | static void r_scil_cal Ihack_receiveend (void)
the ‘r_SC|1_Callb<_';10k_rece|veend’ function A+ Btart user code. Do not edit comment generated here =/
as shown opposite.
. /% Check the contenis of g rx_char %/ -
e Continue to execute the program by { i{f (Cc” == g_rxchar) || (°C" == g rx_char))
) .3} gladc_trigzer = TRUE;
pressing the button. % .
/% Set up SCIS receive buffer and cal lback function azain =/
| R_SCI1_Serial Receive({uint8_t #)ég_rx_char, 1);
/% End user code. Do not edit comment generated here %/
e In the terminal; emulation window, press | static void r_scil_cal Iback_receiveend (void)
the ‘c’ button on the keyboard. /% Start user code. Do not edit comment generated here %/
 The program will halt at the breakpoint in /% Check the contents of e_rx_char / _
the ‘r_scil_callback_receiveend’ function | i{f (Cc” == g m_char) || (°C° == g rx_char))
as show_n opposite. Remove the _ 5 atke trtamer = TRUES
breakpoint by clicking on the breakpoint
column. /x Set uplE:{lE I'%Itéi'u-‘é! il:wuffer and cal Iback function again %/
° Contlnue to execute the program by | R_SGN_SEI’Ial_RBCEIVBf(UIntB_t 3)3~§_r}{_char, ])!
) /% End user code. Do not edit comment generated here =/
pressing the button.
e The program will halt at the breakpoint in || /+-Display-the result-on-the-LC
the main while loop. JE8 | e led display ade(ade _result];
e Remove the breakpoint by clickingonthe | | ----veveeene J#-Increment -the-adc_count- and-
breakpoint column. I i{f' (16-==- (++adc_count))
e Continue to execute the program by | ade_count -=-0;
............ ]
pressing the @ button. | led _display_count {ade_count);
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RSKRX23T 6. Reviewing the Tutorial Program

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSK. Adjust the potentiometer and press any switch on the RSK and an additional A/D conversion will be
performed.

e Press the ‘Stop’ button to halt program execution. —
e This is the extent of the tutorial code. !I

For further details regarding hardware configuration, please refer to the RX Family Software Manual and the RX23T Group
Hardware Manual.

The E1 emulator features advanced logic-based event point trigger system, and full instruction on its use is outside the
scope of this tutorial. For further details, please refer to the E1/E20 Emulator User’s Manual
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7. Additional Information

Technical Support

For details on how to use CS+, refer to the help

file by opening CS+, then selecting Help > Help —
Contents from the menu bar. 20l Window | Help |

) | S ‘@ Help

] @+ Cpen Help for Start Panel F1
ﬂ‘; Cne Point Advice...

B Tutorial

art |

Learn -
@] Browse Renesas Electronics Microcontrollers Web

(i Detail Version Information...

{3} About...

Parts of the sample code provided with the RSKRX23T can be reproduced using the Code Generator plug in
ggllj.me files and functions generated by Code Generator are prefixed with ‘r_"and ‘R_’, respectively.

For information about the RX23T Group microcontrollers refer to the RX23T Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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